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2015 Versions  

Client filter and customized diagnostic templates now available 
with the Troubleshooting Memos 

To assist you in identifying clients that could be affected by the described problems, a downloadable client 
filter and customized diagnostic template is now associated with most Troubleshooting Memos. These 
templates allow you to display a diagnostic in the returns that have tax situations that were the subject of a 
Troubleshooting Memo and provide access to a list of clients affected by the problems described.  

Installing the client filter and diagnostic template 
To find the predefined folder for customized client filters or diagnostics, proceed as follows:  

1. Launch Taxprep.  

2. On the Tools menu, click Options and Settings.  

3. Under Options, click File Locations.  

4. Verify the predefined location for the filters and diagnostics. After the installation, the default location 
is usually the following: My Documents\CCH\T1 Taxprep 2015\Filter and Diagnostics\. 

5. Copy the downloaded file to this location. 
The client filter will be available in the Client Manager, while the diagnostic will display in the relevant 
returns. 

Note: The table below lists all of the client filter templates and diagnostics, which allows you to download 
them separately, depending on the troubleshooting memos and FAQs that relate to you. To download all 
templates in a single operation, click the Download all templates button, then copy all zipped files into the 
folder My Documents\CCH\T1 Taxprep 2015\Filter and Diagnostics\. 

 

 

 

Download all templates 

http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6289
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6289
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6289
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6289
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Publication Problem 
Affected 
Version 

Corrected 
Version 

Identifier 
(to download the 
client filter and 

diagnostic 
template, if 
applicable) 

Week of July 17, 
2016 

T1-ADJ – Incorrect amount 
updated to line 459 when 
the adjustment request is 
prepared automatically 

Version 2015 1.0 

Version 2015 2.0 

Version 2015 3.0 

Version 2015 4.0 

Version 2015 4.1 

Version 2015 4.2 

Version 2016 1.0 T12015-013 

Week of May 1, 
2016 

Schedule Q and amount 
withdrawn from a 
RRIF/RPP/PRPP that is 
greater than the reduced 
2015 minimum amount and 
that is re-contributed to a 
RRIF/RPP/PRPP before 
March 1, 2016 

Version 2015 1.0 

Version 2015 2.0 

Version 2015 3.0 

Version 2015 4.0 

Version 2015 4.2 T12015-012 

Week of 
April 10, 2016 

(Note updated 
the week of 
April 17, 2016) 

RL-10 slip and T5006 slip – 
Unused balance of the 
federal tax credit for 
provincial labour-sponsored 
funds carried forward to 
2016 calculated at a 5% rate 
instead of a 15% rate 

Version 2015 1.0 

Version 2015 2.0 

Version 2015 3.0 

Version 2015 4.0 

Version 2016 1.0 T12015-011 

Week of 
April 10, 2016 

T2038 – The investment tax 
credit balance carried 
forward is incorrect in 
certain situations when the 
credit has been claimed or 
refunded in 2014 

Version 2015 1.0 

Version 2015 2.0 

Version 2015 3.0 

Version 2015 4.0 

Version 2015 4.1 T12015-010 

Week of 
April 10, 2016 

(Note updated 
the week of 
April 17, 2016) 

Newfoundland and Labrador 
HST credit 

Version 2015 1.0 

Version 2015 2.0 

Version 2015 3.0 

Version 2015 4.0 

Version 2015 4.1 T1P2015-009 

Week of 
April 10, 2016 

T2017 – Roll forward of 
reserves for dispositions in 
2014 of qualified fishing 
property, qualified farm 
property and qualified small 
business corporation shares 

Version 2015 1.0 

Version 2015 2.0 

Version 2015 3.0 

Version 2015 4.0 

Version 
2015.4.1 

T12015-008 

http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6585
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6458
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6432
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6421
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6420
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6416
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Publication Problem 
Affected 
Version 

Corrected 
Version 

Identifier 
(to download the 
client filter and 

diagnostic 
template, if 
applicable) 

Week of April 3, 
2016 

Filing due date and balance 
due date 

Version 2015 4.0 Version 2016 1.0 T12015-007 

Week of April 3, 
2016 

Line 318 – Disability amount 
transferred from a 
dependant not calculated 

Version 2015 1.0 

Version 2015 2.0 

Version 2015 3.0 

Version 2015 4.0 

Version 2016 1.0 T12015-006 

Week of April 3, 
2016 

TP1 - Line 424 – Incorrect 
calculation of the tax credit 
for a labour-sponsored fund 
in certain situations 

 

Version 2015 1.0 

Version 2015 2.0 

Version 2015 3.0 

Version 2015 4.0 T12015-005 

Week of 
March 28, 2016 

Line 319 – Carrying forward 
2014 interest on student 
loans – Rolling forward a 
2014 DT Max file 

 

Version 2015 1.0 

Version 2015 2.0 

Version 2015 3.0 

Version 2015 4.0 T12015-004 

Week of 
March 20, 2016 

T5013 slip with both a 
partner code “5” and a 
professional income in box 
120 may create a problem in 
the Québec income tax 
return (TP1) 

Version 2015 3.0 Version 2015 4.0 T12015-003 

Week of 
March 6, 2016 

TaxprepConnect Download – 
Possible duplication of the 
downloaded RL slips when 
the number of downloaded 
RL slips of the same type is 
greater than 9 

Version 2015 3.0 Version 2015 4.0 T12015-002 

Week of 
February 21, 
2016 

EFILE - Result code 183 Version 2015 2.0 Version 2015 3.0 T12015-001 

 

 

 

http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6413
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6408
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6400
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6386
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6366
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6345
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6288
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Federal 

Troubleshooting T12015-013 

T1-ADJ – Incorrect amount updated to line 459 when the adjustment request is prepared 
automatically 
 

 

Problem: 
When a Form T1-ADJ is prepared automatically to correct the amount claimed for the children’s fitness tax 
credit (line 459 of the federal tax return), the amount updated to line 459 of Form T1-ADJ is not the amount of 
the credit, but the amount of fees paid, which is incorrect. 

 

 
 

 

 

 

 

 

 

Download the client filter and diagnostic template 

http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6585
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6585
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6585
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6585
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6585
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Solution: 
There are two possible solutions: 

If you want Form T1-ADJ to be prepared automatically (for example, in the case where several lines must be 
adjusted in addition to line 459), proceed as follows once Form T1-ADJ is printed: cross off number “459” and 
the title “Children’s fitness tax credit,” and manually write number “458” as well as the title “Eligible fees.” 

 
If you prefer completing Form T1-ADJ manually, proceed as follows: 

1. Clear the appropriate box on line Prepare an automatic T1-ADJ form. 

2. Answer “Yes” to the question you are asked. 
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3. In Section C, “Adjustment details,” enter “458” in the column Line number from return or schedule and 
“Eligible fees” in the column Name of line from return or schedule, and enter the previous amount as 
well as the revised amount. 

 
This problem will be corrected in Personal Taxprep 2016 v.1.0. 

 

Troubleshooting T12015-006 

Line 318 – Disability amount transferred from a dependant not calculated 
 

 

Problem: 
The disability amount transferred from a dependant is not claimed on line 318 of the taxpayer’s Schedule 1 
and/or the spouse’s Schedule 1 when all of the following conditions are met: 

− the taxpayer’s and the spouse’s returns were not coupled in 2014: 
− more than one dependant was identified in the taxpayer’s or the spouse’s FAM form in 2014, and at 

least one of these dependants was eligible for the disability amount: 
− after rolling forward the client file to the 2015 taxation year, the returns of the taxpayer and the 

spouse have been coupled. 

Solution: 
To solve this problem, you have to follow one the procedures proposed below for each dependant eligible for 
the disability amount, depending on whether the return of the dependant is coupled or not. 

If the return of the dependant is coupled 

1- In the FAM form, select the copy of the dependant who is eligible for the disability amount. 

2- Clear the box Add a dependant’s return. 

 

Download the client filter and diagnostic template 

http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6408
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6408
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6408
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6408
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6408
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3- Answer “Yes” to the first question you are asked, and “Yes” to the second question. 

 

 
You must then enter a file name and save the client file. 

 
4- Close the return that you just saved before you continue. To do so, selected the saved file in the Client 
drop-down list and choose Close Tax Return (Ctrl+W) in the File menu. 
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5- Go back to the FAM form of the client file affected by this problem and delete the copy of the dependant 
eligible for the disability amount. 

 

6- Still in the FAM form, create a new copy. 

 
7- Select the box Add a dependant’s return and select Current year return. 
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8- Open the client file that you saved at step 3. 

 
9- Answer “Yes” to the question you are asked. 

 

10- Verify the information shown on the Family Profile form of the dependant whose return you added at 
step 7 to make sure that his or her profile is complete. 

If the return of the dependant is not coupled 

1- Create a new copy in the FAM form. 

 
2- Select the copy of the dependant who is eligible for the disability amount. 

3- In the Edit menu, click Select Input Cells (or press Ctrl+F7). Then, select Copy in this menu (or press 
Ctrl+C). 

4- Access the new copy created and choose Paste Form in the Edit menu. 
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5- Answer “Yes” to the question you are asked. 

 
6- Delete the dependant’s copy resulting from the roll forward (the one you had selected at step 2). 

 

 

 

Troubleshooting memo T12015-003 

T5013 slip with both a partner code “5” and a professional income in box 120 may 
create a problem in the Québec income tax return (TP1) 
NOTE: This troubleshooting applies when all of the following conditions are met: 

• the TP1 module (Québec) is installed;  
• the taxpayer covered by the return is in a multiple jurisdiction situation; 
• the T5013 slip includes several boxes 120, one of which is for Québec allocation; and 
• the T5013 includes a partner code “5” in box 002. 

 

 

Problem: 
When a T5013 slip has a partner code “5” in box 002 and professional income is shown in several boxes 120, 
including one for Québec allocation, the Québec allocation appears to be incorrect on Form TP-22/TP-25, 
Detail of Net Income from Businesses Carried on in Québec (Jump Code: Q22 Q25 D). 

Depending on the order the data has been entered on the T5013 data entry screen, it is possible that the 
income allocated to the TP1 return for this specific T5013 slip will either be missing or duplicated on 
Form TP-22/TP-25 (Jump Code: Q22 Q25 D) when the partner code on the T5013 slip is “5” and income is 
shown in boxes 120. 

Download the client filter and diagnostic template 

http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6366
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6366
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6366
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6366
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6366
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Situation 1 (the amout is being duplicated on Form TP-22/TP-25 (Jump Code: Q22 Q25 D)): 

 
Situation 2 (the amount is missing on Form TP-22/TP-25 (Jump Code: Q22 Q25 D)): 

 

Solution: 
In order to rectify both situations, simply change the partner code from “5” to “2” on the T5013 data entry 
screen. 

If you have entered a code “5” in the T5013 slip and the income is already correctly allocated on 
Form TP-22/TP-25 (Jump Code: Q22 Q25 D), you are not required to change the code. 
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Note that partner codes “2” or “5” have the same purpose in Personal Taxprep when professional income is 
reported in boxes 120 of the T5013 slips. Furthermore, those codes are not included in the federal and Québec 
income tax returns that you file. 

 
The income will then be displayed correctly on Form TP-22/TP-25 (Jump Code: Q22 Q25 D) and Form TP22 or 
TP25, depending on which situation applies. 

  
This problem will be corrected in Personal Taxprep 2015 v. 4.0.  

Québec 

Troubleshooting Memo T12015-012 

Schedule Q and amount withdrawn from a RRIF/RPP/PRPP that is greater than the 
reduced 2015 minimum amount and that is re-contributed to a RRIF/RPP/PRPP before 
March 1, 2016 
 

 

Problem: 
If an amount withdrawn from a RRIF/RPP/PRPP is greater than the reduced 2015 minimum amount and is 
re-contributed to a RRIF/RPP/PRPP before March 1, 2016, it can be deducted on line 232 of the federal income 
tax return and on line 250, point 04, of the Québec income tax return. 

If a taxpayer in this situation wants to split pension income with his or her spouse, the amount eligible for the 
split corresponds to the amount withdrawn less the amount re-contributed. The amount that can be split is 
correctly updated to Form T1032, which is used to calculate the income split in the federal income tax return. 
However, the amount that can be split that is updated to Schedule Q, which is used to calculate the income 
split in the Québec income tax return, does not take into account the re-contributed amount deducted at 
point 04 of line 250. Where applicable, the Québec amount that can be split is overvalued. 

 

 

Download the client filter and diagnostic template 

http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6458
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6458
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6458
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6458
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6458
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Example: 

In 2015, John withdrew $25,000 from his RRIF, which represents the minimum amount that can be withdrawn 
under former rules relating to the calculation of the required minimum withdrawal. In accordance with the 
new rules, the new minimum withdrawal amount is $20,000. John decided to contribute the excess amount of 
$5,000 in his RRIF. The amount eligible for the pension income split is therefore $20,000. 

Federal income tax return, Form T1032: 

 

Québec income tax return, Schedule Q: 

 

Solution: 
To correct the amount that can be split in Schedule Q, add, on line 12 of Schedule Q, the amount 
re-contributed to a RRIF/RPP/PRPP, using an override, then recalculate the split pension amount using the 
Calculate button in Form T1032. 

In the case of John, he must therefore enter an amount of $5,000 on line 12 of Schedule Q, using an override, 
in order for the amount used for the split to be $20,000. 
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Because the deduction for an amount withdrawn from a RRIF/RPP/PRPP that is greater than the reduced 2015 
minimum amount and that is re-contributed to a RRIF/RPP/PRPP before March 1, 2016, is a temporary 
deduction only applicable to the 2015 taxation year, this problem will no longer be present in Personal Taxprep 
2015 v.4.2. 

 

Troubleshooting Memo T12015-011 

RL-10 slip and T5006 slip – Unused balance of the federal tax credit for provincial labour-
sponsored funds carried forward to 2016 calculated at a 5% rate instead of a 15% rate  

 
 

Problem: 
In the RL-10 slip and the T5006 slip, a section has been added to calculate the credit balance of the federal 
labour-sponsored funds. In this new section, the closing balance of this credit, which will be carried forward to 
2016, is calculated with a 5% rate. However, in accordance with the measures announced in the latest federal 
budget, the rate of the tax credit for a provincial labour-sponsored funds will be 15% instead for the 2016 
taxation year. As for the federal labour-sponsored funds, it will remain at 5% for 2016. 

Example: 

A $5,000 investment is made in a provincial labour-sponsored funds in the first 60 days of 2016, and no credit is 
deducted on line 414 of Schedule 1. 

In this situation, the program displays the following results in the RL-10 slip or the T5006 slip: 

 
The program calculates a $250 credit to carry forward (i.e. 5% of $5,000), while in fact, the amount of the 
credit carried forward that could be deducted in the 2016 tax return would be $750 (i.e. 15% of $5,000). 

 

 

Download the client filter and diagnostic template 

http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6432
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6432
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6432
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6432
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6432
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Solution: 
There are two possible solutions: 

The first solution is not to make any modifications in the RL-10 slip or the T5006 slip. When rolling forward the 
client file with version 2016 of Personal Taxprep, the balance will be modified to reflect the 15% rate. 

In this example, when rolling forward the client file with version 2016 of Personal Taxprep, the balance carried 
forward from 2015 would be $750. 

The second solution is to override the closing balance to indicate the carried forward credit calculated with 
the 15% rate. If you perform an override in the RL-10 slip or the T5006 slip, following the roll forward of the 
client file with version 2016 of Personal Taxprep, the opening balance will correspond to the amount that had 
been overridden in the RL-10 slip or the T5006 slip of the 2015 version. 

By overriding the federal labour-sponsored funds amount carried forward, you will ensure that the balance to 
carry forward displayed in Forms ACCT SUM, CFSUM and QC CFSUM is correct. 

In Form T5006, the closing balance of the federal funds should not be modified, because the 5% rate applies to 
the federal labour funds for the 2016 taxation year. 

This problem will be corrected in Personal Taxprep 2016 v.1.0. 

 

Troubleshooting Memo T12015-005 

TP1 - Line 424 – Incorrect calculation of the tax credit for a labour-sponsored fund in 
certain situations 

 
 

Problem: 
The amount of the tax credit for a labour-sponsored fund is incorrectly calculated on line 424 of the TP1 return 
when the taxpayer received one or more RL-10 slips and the following conditions are met: 

• an amount is shown in box G1, Amounts paid before June 1; 
• an amount is indicated in either box A, Amounts paid during the period to purchase shares in the fund, 

or box G2, Amounts paid after May 31, and/or an unused balance of the tax credit for a labour-
sponsored fund has been carried forward from 2014; and  

• the total of boxes G1, G2, A, and the investment amount corresponding to the unused credit balance 
for 2014 exceeds $5,000. 

 
In this situation, the credit calculated on line 424 will be less than the maximum amount that can be claimed 
and, as a result, a balance will be carried forward to 2016. 

Solution: 
This problem has been corrected in Personal Taxprep 2015 v.4.0. 

If the tax return has not yet been filed, opening and saving the client file with version 4.0 will correct the 
amount on line 424 of the TP1 return. 

Download the client filter and diagnostic template 

http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6400
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6400
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6400
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6400
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If the tax return has been filed with a version prior to version 4.0 and you want to modify the credit amount, 
file Form TP-1.R, Request for an Adjustment to an Income Tax Return (Jump Code: QTP1R). If the return has 
been filed via NetFile Québec with a version prior to version 4.0, you can verify the amount that has been 
claimed on line 424 of the TP1 return by reviewing Form QEFILE SUM. 

 

If you do not want to modify a tax return that has already been filed with a version prior to version 4.0, it is 
important not to open and save the client file in version 4.0. 

Newfoundland and Labrador 

Troubleshooting memo T12015-009 

Newfoundland and Labrador HST credit 
 

 

Problem: 
In its 2016-2017 Budget, Newfoundland and Labrador announced the replacement of the sales tax credit by a 
new benefit, the Newfoundland and Labrador income supplement. This measure applies commencing in the 
2016 taxation year, and the Newfoundland and Labrador income supplement will be paid at the same time as 
the low income seniors’ benefit. 

The most recent budget also sets forth the increase in the base amount in accordance with the low income 
seniors’ benefit. 

However, in all versions of Personal Taxprep 2015, the Newfoundland and Labrador sales tax credit is 
calculated, and the low income seniors’ benefit takes the old amounts and rates into account. 

Solution: 
Cancel the calculation of the sales tax credit as well as the calculation of the low income seniors’ benefit, 
because we do not yet have all of the required information to correctly calculate this benefit. 

For more information on the new income supplement as well as the low income seniors’ benefit, consult the 
2016-2017 Newfoundland and Labrador Budget by clicking the following link: 
http://www.releases.gov.nl.ca/releases/2016/fin/0414n03.aspx. 

To cancel the sales tax credit and the low income seniors’ benefit, override line 14 with “0,” at the bottom of 
Form GSTC, Goods and Services Tax Credit (Jump Code: GSTC). 

Download the client filter and diagnostic template 

http://www.releases.gov.nl.ca/releases/2016/fin/0414n03.aspx
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6420
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6420
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6420
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6420
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This problem will be corrected in Personal Taxprep 2015 v.4.1. 

 

TaxprepConnect 

Troubleshooting memo T12015-002 

TaxprepConnect Download – Possible duplication of the downloaded RL slips when the 
number of downloaded RL slips of the same type is greater than 9 
 

 

Problem: 
When the number of RL slips of the same type downloaded from Revenu Québec is greater than 9 and the 
RL slips of this type are manually linked by the preparer to slips downloaded from the CRA, those RL slips are 
duplicated in the TaxprepConnect Download form. Because the program selects by default all of the slips for 
transfer to the return, certain amounts might be duplicated in the return. 

 

Download the client filter and diagnostic template 

http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6345
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6345
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6345
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6345
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6345
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Solution: 
To prevent data to be duplicated during the transfer to the return, make sure to clear the transfer boxes for 
the duplicated RL slip, as depicted below. 

 
This problem will be corrected in Personal Taxprep 2015 v.4.0. 

 

Electronic Transmission 

Troubleshooting memo T12015-001 

EFILE - Result code 183 
 

 

Problem: 
I transmitted a T1 return with Personal Taxprep 2015 v.2.0 and received a “Not transmitted” message with no 
description. My return is still eligible and there is no confirmation number in the client file. 

When I contacted the CRA EFILE helpdesk, they confirmed that the return had been accepted with a Result 
code 183. 

 

Solution: 
You can now EFILE a return in which a disability amount is claimed even if Form T2201, Disability Tax Credit 
Certificate has not yet been received by the CRA or if a new Form T2201 is required. 

In those situations, the Result code 183 is returned by the CRA and the return is accepted, but the following 
CRA message should have been displayed in Taxprep: 

Download the client filter and diagnostic templates 

http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6288
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6288
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6288
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6288
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6288
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The <tax year> for <taxpayer’s name> has been successfully received by the Canada Revenue Agency. 
The same selection criteria for verifying income tax returns are used for both paper and electronic 
versions. Your client needs to keep all tax information slips and documents for six years after you filed 
the tax return. Please keep this confirmation number and DCN for your records: ####### - 
############# 
There is no approved Form T2201, Disability Tax Credit Certificate on record for this taxpayer with the 
Canada Revenue Agency for this tax year. The claim for the disability amount will be reviewed before 
we assess this return. This may cause delays. 

Note that for technical reasons, this specific message cannot be displayed in the EFILE Transmission Results 
dialog box and the EFILE status cannot be updated correctly in Personal Taxprep 2015 v.2.0. 
However, you can view the message and your confirmation number if you click the CRA Detailed version 
button located at the bottom left-hand corner of the EFILE transmission Result dialog box. 
If you want, you can also contact the CRA EFILE helpdesk to receive the confirmation number over the phone. 

 
Once you have this information, you can manually change the EFILE status from “Eligible” to “Accepted” and 
enter the confirmation number in the “Notes” field of the Properties dialog box (F11). 
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Alternatively, you can also enter the confirmation number as an “attached note” in the confirmation number 
cell in Form EFILE INFO (Jump Code: EFILE INFO). 

 
Although all returns in which a disability tax credit has been claimed will be correctly transmitted to the CRA 
with version 2, we suggest that you wait, if possible, for version 3 before transmitting such returns (especially 
if you are unsure whether or not the CRA has an approved Form T2201 on record) in order to have your file 
automatically updated with the proper EFILE status and confirmation number. 

This problem will be corrected in Personal Taxprep 2015 v. 3.0. 

Roll forward 

Troubleshooting T12015-010 

T2038 – The investment tax credit balance carried forward is incorrect in certain 
situations when the credit has been claimed or refunded in 2014 
 

 

Problem: 
An investment tax credit balance carried forward can be rolled forward by error into Form T2038 when the 
credit has been claimed or refunded in 2014. This problem occurs when, in 2014, an investment tax credit has 
been calculated with amounts that had been overridden on lines 6712, 6715, 6714 or 6723 in Part A of 
Form T2038 of 2014. 

Personal Taxprep 2014 

 
Even if part or all of this credit has been claimed on line 412 of Schedule 1 or refunded on line 454 of the 2014 
tax return, the program rolls forward a balance carried forward from 2014 to the “Analysis of ITC 
claimed/carried forward” section of Form T2038 rather than deem the credit claimed. 

Download the client filter and diagnostic template 

http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6421
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6421
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6421
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6421
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6421
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Personal Taxprep 2014 

 
When rolling forward such a client file into version 2015 of Personal Taxprep, this balance is rolled forward into 
the “Analysis of ITC claimed/carried forward” section of Form T2038. 

Personal Taxprep 2015 

 
Solution: 
Verify the opening balance on the “Analysis of ITC claimed/carried forward” worksheet of Form T2038 and, 
where applicable, use an override to correct this amount. 

A client filter has been created to allow you to identify the files in which the investment tax credit balance 
should be verified. 

This problem will be corrected in Personal Taxprep 2015 v.4.1. 
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Troubleshooting Memo T12015-008 

T2017 – Roll forward of reserves for dispositions in 2014 of qualified fishing property, 
qualified farm property and qualified small business corporation shares 

 
 

Problem: 
The amount rolled forward on the line Other – after March 18, 2007 but before 2014 of section A in Form T2017 
is incorrect, as this amount includes reserves for dispositions made after March 18, 2007 but before 2014 and 
reserves for dispositions in 2014. The amount of reserves for dispositions in 2014 should instead be entered on 
the line Other – in 2014 (see the screen capture below). 

 

The amount rolled forward on the line Other – after March 18, 2007 but before 2014 of section B in Form T2017 
is incorrect, as this amount includes reserves for dispositions made after March 18, 2007 but before 2014 and 
reserves for dispositions in 2014. The amount of reserves for dispositions in 2014 should instead be entered on 
the line Other – in 2014 (see the screen capture below).  

 
This problem affects files rolled forward from Taxprep, Cantax, Profile and DT Max 2014. 

Download the client filter and diagnostic templates 

http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6416
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6416
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6416
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6416
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6416
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Solution: 
In both sections affected by the problem, modify the amount rolled forward on the line Other – after March 18, 
2007 but before 2014  in order to include only reserves for dispositions after March 18, 2007 but before 2014. 
Then, enter the amount of reserves for dispositions in 2014 on the line Other – in 2014. 

This problem will be corrected in Personal Taxprep 2015 v.4.1. 

 

Troubleshooting T12015-004 

Line 319 – Carrying forward 2014 interest on student loans – Rolling forward a 2014 
DT Max file 
 

 

Problem: 
As a result of the roll forward of a 2014 DT Max file, the amount of interest on student loans for 2014 to carry 
forward to the following years is incorrect when an amount has been claimed on line 323, Your tuition, 
education and textbook amounts (attach Schedule 11), of the taxpayer’s Schedule 1 for 2014. 

When rolling forward the DT Max file in Personal Taxprep, the amount that had been claimed on line 323 of 
Schedule 1 in 2014 is added to the 2014 amounts carried forward to Form Schedule 1 Line 319, Interest Paid on 
Student Loan (Jump Code: 319), which is incorrect. 

Example 1: 

A credit of $1,500.00 has been claimed on line 323 of Schedule 1 for 2014, and there is no balance of interest 
on student loans for 2014 to carry forward to 2015. 

As a result of the roll forward to Personal Taxprep, an amount of $1,500.00 is indicated as the balance of 
interest on student loans for 2014, which is incorrect. 

Example 2: 

A credit of $1,500.00 has been claimed on line 323 of Schedule 1 for 2014, and there is a $600 balance of 
interest on student loans for 2014 to carry forward to 2015. 

As a result of the roll forward to Personal Taxprep, an amount of $2,100.00 is indicated as the balance of 
interest on student loans for 2014, which is incorrect. This error results from the fact that the program 
currently adds the amount of $1,500 to the amount of $600. 

Solution: 
In example 1 above, delete the amount rolled forward for interest carried forward for 2014. 

In example 2 above, modify the amount rolled forward for interest carried forward for 2014. The amount to 
enter is $600. 

The roll forward problem of DT Max files will be corrected in Personal Taxprep 2015 v.4.0. The files rolled 
forward with this version will therefore not be affected by this problem. However, using version 4.0 to open a 
client file rolled forward with a prior version will not correct this problem. In this situation, manually modify 
the balance by subtracting from the balance of interest carried forward for 2014, the amount on line 323 
of 2014. 

 

 

 

 

 

 

Download the client filter and diagnostic template 

http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6386
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6386
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6386
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Letter 

Troubleshooting T12015-007  

Filing due date and balance due date  

 

 

Problem: 
When the general filing date and the balance due date have been modified for May 2, 2016, in the CLIENT 
LETTER tab in the preparer profile used, this change is no longer reflected in the client letters as of 
version 2015 4.0. 

 

Solution: 
If you are preparing the return of a taxpayer who has no spouse and who is not self-employed, access the 
Client Letter Worksheet (Jump Code: LW), and modify the dates as follows, using overrides: 

 

If you are preparing the return of a taxpayer and the return of the spouse and the taxpayer and/or the spouse 
are self-employed, only the balance due date should be modified, as follows, in the return of the taxpayer and 
the return of the spouse: 

 

Note that this action must be done for each of the returns filed. 

This problem will be corrected in Personal Taxprep 2016 v.1.0. 

Download the diagnostic template 

http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6413
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6413
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6413
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6413
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6413
http://tc.cch.ca/cchservices/download/pushdocs.asp?doc=6413
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